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Introduction 

Late Glacial finds in Denmark are, when compared 
to other periods, relatively rare (https://slks.dk/file-
admin/user_upload/kulturarv/publikationer/em-
neopdelt/arkaeologi/aud/reg-kronologi.pdf ), with 
a small number of contexts representing, following 
traditional cultural assignment, the Hamburgian 
(c. 12500-12000 cal BC), Federmesser (c. 12000-
10800 cal BC), Bromme (c. 11500-10500 cal BC) 
and Ahrensburgian (c. 11000-10000 cal BC) cul-
tures. Perhaps one of the most frequently found 
typological and taxonomic entities throughout this 
period is the Bromme culture, representing the ma-
jority of entries in the Fund & Fortidsminder (Sites 
and Monuments Record), provided by the Danish 
Agency for Cultures and Palaces (Riede 2017a).

The status of these cultures, the transitions be-
tween and the causes underlying the attendant mate-
rial culture changes observable in the archaeological 
record are currently much debated (Buch Pedersen 
2014; Riede 2013; 2014; Riede & Pedersen 2018; 
Sauer & Riede 2018; Weber et al. 2011). The diffi-
culties of disentangling these patterns and processes 
of culture change are, in part grounded in the scarci-

ty of well-described sites. Of the Late Glacial entries 
in the Danish Sites and Monuments Record (Fund 
& Fortidsminder), the majority of find spots actu-
ally represent stray-finds of either projectile points 
or knapping debris; larger and well-described as-
semblages are rare (Riede 2017b:27-31). This reg-
ister is used primarily for administrative purposes, 
however, and changes in registration practice over 
time and between the many registrants are difficult 
to account for. Nonetheless, the database still offers 
the most immediate overview of the archaeological 
finds from present-day Denmark.

In a recent review of the Danish Final Palaeo-
lithic, the site of Skovmosen I on Zealand in eastern 
Denmark has been listed among those assemblages 
(Brinch Petersen 2009), yet the material has only 
very briefly been described previously and never be-
fore in English (Boye 2006; Hilgart 2003). We here 
offer an in-depth description of legacy materials as-
sociated with the Skovmosen assemblage. 

In a collaboration initiated by the site’s discov-
erer Jan Hilgart, this paper details a selection of ar-
tefacts recovered from the Final Palaeolithic locale, 
Skovmosen I, in eastern Denmark. We present an 
overview of the locale and couple this with a tech-
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nological analysis of the assemblage, including ob-
servations made at the time of discovery and initial 
retrieval. Furthermore, in the promotion of accessi-
bility (Marwick 2017), we present digital models of 
selected artefacts, and finally attempt to place Skov-
mosen I in a wider context of the Final Palaeolithic 
in the region.

Skovmosen

Skovmosen I (Sted & lok. nr. 020307-178) is lo-
cated in the present municipality of Lyngby-Taar-
bæk, Zealand, in eastern Denmark, situated be-
tween Kongens Lyngby and Jægersborg north of 
Copenhagen (Figure 1). Following an expansion 
of the Helsingør motorway in 1995, one of the 
authors ( Jan Hilgart) discovered several Final Pal-
aeolithic flint artefacts along the edge of a tunnel 
valley close to the remains of the present-day bog 
of Skovmosen. Skovmosen, literally meaning ‘the 
forest bog’, is situated at the bottom of a small hill 
and on the northern shore of the bog (Figure 2). 
The site is situated on the eastern side of the mo-
torway, approximately 300  meters northwest of 
the late 19th century historical monument of Gar-
derhøjfortet. 

As part of the motorway construction, a small drain-
age canal, which would lead surface water away from 
the road, was dug to the adjacent bog. It was at the 
construction site and among the spoil heaps from 
this drainage that the lithic artefacts were retrieved. 
As the site seemed heavily disturbed by the con-
struction, permission was given, through a collabo-
ration with Københavns Amtsmuseumsråd, to sieve 
the spoil heaps and retrieve any additional artefacts. 
This salvage operation at the site was stalwartly con-
tinued and the spoil heaps were systematically sieved 
through the winter of 1995/1996. In total, 240 arte-
facts were recovered.

Today, the area of Skovmosen falls under the 
jurisdiction of Kroppedal Museum and the assem-
blage is currently on display at Friboeshvile Manor 
in Lyngby. Although the site is briefly mentioned by 
Hilgart (2003), Boye (2006) and Brinch Petersen 
(2009), we here provide a first detailed account and 
description of the material in English, with particu-
lar focus on the blades, tools and cores.

Locational context and discovery 

As no excavation was carried out due to the site’s 
disturbed condition, no definite location or extent 

Figure 1. The location of Skovmosen I in northern Zealand, Denmark.
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can be established. From observations made by 
Hilgart during the discovery and his subsequently 
made map, it can be surmised that at least one, and 
possibly two, concentrations are represented in the 
material, which were situated in peaty soil with a 
sandy subsoil. Both concentrations were most like-
ly located near the shoreline of the bog/palaeolake, 
adjacent to the motorway. The lithic material was 
distributed across an area measuring approximate-
ly 240-250 m2 in total. Observations made at the 
time of discovery suggest, that the drainage canal 
had intersected a single scatter of lithic material, 
representing – potentially – a coherent site. By the 
same token, it is important to note that one of the 
artefacts recovered around the spoil heaps was a Late 
Mesolithic transverse arrowhead. Some mixing – es-
pecially at the locales eastern end – had evidently 
occurred, although whether this mixing relates to 
multiple occupations or the very process that led to 
the discovery of the assemblage – or some combina-
tion of these factors – remains entirely speculative. 
Prehistoric occupation at the site well after the Final 
Palaeolithic is certainly implicated and must be tak-
en into account when considering the assemblage.

Lithic analysis 

Of the 240 artefacts recorded, we selected five for 
3D documentation by means of Structure from 
Motion (SfM): one complete tanged point (x2), 
one incomplete tanged point (x1), one scraper 
(x29) and two cores (x48 and x51). A copy of the 

fully interactive models can be retrieved from our 
Open Science Framework (OSF) project page:                                    
https://osf.io/jeuxf/. 

Although photogrammetry has been a compel-
ling approach, not only within archaeology but oth-
ers disciplines within recent years (Baier & Rando 
2016; De Reu et al. 2013; Green et al. 2014; Grün 
et al. 2004; López et al. 2016; Westoby et al. 2012), 
the methodology has not gained momentum when 
it comes to presenting lithic assemblages. In particu-
lar with regard to archaeological lithics, drawing 
curiously persists as the preferred standard mode 
of representation, despite the evident differences in 
stylistic approaches (Saville 2009) and the fact that, 
in most other sciences, drawing is restricted to ide-
alised representations rather than actual specimens 
(Lopes 2009). In contrast to drawing, SfM con-
structs a 3D model based on regular overlapping 
2D photographs of a given artefact, capturing the 
object’s shape and from. It does so by identifying 
pixel-by-pixel spatial information in each photo-
graph needed for triangulation, and by then using 
corresponding points on different overlapping pho-
tographs, to render a model in a dimensionally sta-
ble Euclidean space.

We used a portable photogrammetry rig to re-
cord the artefacts, adapted from the setup report-
ed by Porter et al. (2016). For the necessary level 
of detail, a 50MP Canon EOS 5DS with a 50 mm 
macro lens was used to obtain the overlapping pho-
tographs, following the detailed workflow presented 
in Appendix 1. Note that, evidently, a refinement of 
these latter protocols is still necessary. Even when 

Figure 2. Photograph of Skovmosen I,     
taken by J. Hilgart.
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substantial efforts are made to standardise recording 
procedures, the results of individual capture events 
vary. To facilitate offline reading, lithic illustrations 
therefore also accompany this article. In recording 
the technological attributes of the assemblage, the 
“Dynamical Technological Classification of Scan-
dinavia Lithic Blade Industries”, made accessible by 

the Nordic Blade Technology Network (Sørensen 
2013) was adopted.

Typological and technological analysis 

The Skovmosen I lithic material is characteristic 
of an assemblage recovered through surface recon-
naissance. The assemblage consists of material at all 
stages of production, with primary material (cores, 
unretouched blades and debitage) and secondary 
products (burins, scrapers and tanged points) pres-
ent (Table 1); smaller debitage, however, is lacking. 
An illustration of a selection of artefacts can be seen 
in Figure 3.

Raw material

The lithic material is covered by red to olive colour-
ed patina rendering an exact classification of the raw 
material used in the assemblage difficult. On pieces 
which are only partly covered by patina, the material 
appears to be Cretaceous (Senonian) flint. 

Primary reduction products

Blades
In total, 17 complete blades were identified, as well 
as a further four fragments. Of the latter, two can be 
refitted into one complete blade (x18) and are there-
fore treated as such in this analysis. The blades vary 

Category Sub-category Count (∑=240)

Secondary reduction production Tanged point (complete) 1
Tanged point (broken) 4
Transverse arrowhead 1

Scraper 22
Burin 8

Combination tool 1
Primary reduction production Blade (complete) 17

Blade (broken) 2
Blade core 5
Flake core 7

Debitage 172

Table 1. Breakdown of artefacts from Skovmosen I.

Figure 3.Top row, from left to right: cores (x48, x51). Middle 
row, from left to right: a selection of scrapers (x29, x28, 
x43, x46). Bottom row, from left to right: a selection of tan-
ged points (x1, x2, x3). Illustrations by J. Hilgart.
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from regular (n = 12) to widely-irregular (n = 6) ex-
amples, with a large number of blades showing signs 
of preparation of the core prior to the production of 
the blade (n = 12). A considerable number of blades, 
where observable, also indicate the use of direct hard 
knapping technique, with large and thick butts, and 
pronounced bulb formation (n = 6). Experimental 
analyses have shown, however, that unambiguous 
discrimination between direct soft and hard hammer 
percussion is difficult (Damlien 2015; Darmak & 
Apel 2008), with important implication for the va-
lidity of traditional inferences of hammer types from 
bulb morphology (e.g. Hartz 1987).

Cores
In total, 12 cores were identified throughout the 
assemblage. These relatively small pieces range in 
height from 22 mm to 69 mm, with an average of 
41.9 mm. The majority of cores are conical in mor-
phology (n = 10), and feature a single striking plat-
form (n = 11). Only one core (x62) exhibits two 
striking platforms. A single-front or circular exploita-
tion method is typically represented, with cortex lo-
calised and positioned on the ‘back’ of the core.

Five cores can be categorised as blade cores, four of 
which feature a relatively high core flatness, oriented 
towards blade and bladelet production (Figure 4). All 
five blade cores feature a single smooth platform and 
a conical morphology, and demonstrate successful 
blade and bladelet production, with very few exam-
ples of stepped or hinged negative distal-end scars on 
their circumference. One core (x48) is the exception 
to this rule, with multiple hinged and stepped nega-
tive distal-end scars, layered around the core’s circum-
ference (Figure 5). This example is also of greater size 
(15 mm longer than all other blade cores), exhibits a 
greater number of blade and bladelet removals, and 
is the only example to feature platform grinding and 
abrasion. Despite of the presence of many cores, no 

hammerstones were recovered from the site. Howev-
er, deep negative scars on the majority of cores, fol-
lowing the above frameworks, allude to their use.

Tools

Burins
The burins (n = 8) are all dihedral burins on an 
edge, made on thick blades most likely produced by 

Figure 4. From left to right; textured 3D model and mesh 
view of x51. 

Figure 5. From left to right; textured 3D model and mesh 
view of x48. 

Figure 4a. 3D rendered model of x51. 

Figure 5a. 3D rendered model of x48. 
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hard-hammer percussion. One is significant in hav-
ing a retouched tang in the proximal end, and may 
be the resulting modification or re-tooling on a frac-
tured tanged artefact, such as a projectile point. An-
other can be described as a combination tool with a 

dihedral burin on an edge in one end and concave 
retouch on the other end.

Scrapers
Scrapers make up the largest part of the tool assem-
blage (n = 22). These primarily consist of scrapers 
made on flakes (n = 14) where the bulk are made 
into smaller and almost circular ‘thumbnail’ scrapers 
(n = 12). Scrapers on blades are represented as well 
(n = 8). Only one scraper preserves an intact bulb 
and butt indicating a direct hard percussion tech-
nique, fully in line with the evidence from primary 
production.

Tanged points
Finally, the assemblage contains five large tanged 
points, one complete and four fractured. Artefact x1 
is a slightly fractured tanged point, with minor dam-
age at the distal end (Figure 7). This is, however, a 
clean unpatinated break and represents a post-dep-
ositional breakage. It is therefore here regarded as a 
whole artefact. This example is made from a thick 
regular blade, with two dorsal ridges and an evenly 
distributed curvature. It measures 66 mm in length, 
25 mm in width, 8 mm in thickness and weighs 
13.2 g. The tang is located at the proximal part 
where the rather thick and unfaceted platform and 
pronounced bulb are still intact. The tanged retouch 
is featured on both sides of the tang and is knapped 
from the ventral side of the blade. The blade features 
converging edges towards the distal end.

Artefact x2 is a complete projectile point meas-
uring 53 mm in length, 18 mm in width, 6 mm in 
thickness and weighing 3.4 g (Figure 8). Technolog-
ically similar to x1, this point is made from a regular 

Figure 7. From left to right; textured 3D model and mesh 
view of x1. 

Figure 6. From left to right; textured 3D model and mesh 
view of x29. 

Figure 6a. 3D rendered model of x29. 

Figure 7a. 3D rendered model of x1. 
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blade, with two dorsal ridges and a tang located at 
the proximal end. The tang-forming retouch is ap-
plied on both sides, from the ventral side of the blade 
as on x1, but here removing the platform and bulb. 
The distal portion of the projectile has been made to 
converge with small scalar retouch. The weight and 
dimensions of these more or less complete points 
aligns them well with ethnographically documented 
dart-heads (Riede 2009). 

Artefacts x3, x4 and x5 are all projectile point 
fragments and specifically, tang fragments. The 
presence of such fragments, together with prima-
ry production of blades, may provide insights into 
some of the activities at the site. The fracturing of 
these projectile points could have been the result of 
impact damage from hunting (Fischer et al 1984). 
It may also indicate re-tooling of the damaged pro-
jectile points upon return from the hunt. Similar to 
x2, x3 is made from a regular, rather slender, blade 
with two dorsal ridges and retouch on both sides at 
the proximal end, from the ventral side of the blade, 
and the bulb removed. Artefact x4 is also made 
from a regular, slender blade with two dorsal ridg-
es with retouch on both sides, at the proximal end 
from the ventral side of the blade. Contrary to x2 
and x3, the bulb and striking platform are here in-
tact. Artefact x5 is also made from a regular, slender 
blade with two dorsal ridges and retouched on both 
sides at the proximal end from the ventral side of the 
blade. Both the bulb and striking platform on x5 are 
intact.

Debitage

A total of 173 debitage pieces were collected, of 
which 57 % demonstrate signs of hard percussion 
technique, 15 % attest to the likely use of a softer 
hammer or indirect percussion and a further 28 % 
could not be determined. 61 % of the debitage re-
tain some cortex, underlining that primary lithic 
reduction might have been taking place at the site. 

The place of the Skovmosen assemblage 
in the Danish Final Palaeolithic 

Located on slightly higher ground near a body of 
freshwater, the Skovmosen site shows a locational 

position common for the southern Scandinavian 
Late Glacial. In this, Skovmosen is comparable to 
larger sites such as Trollegave, Stoksbjerg Vest and 
Bro, which also are located near lakes ( Johansen 
2003; Pedersen 2009:120). Such a location could, 
following Fisher (1991), Donahue and Fisher 
(2015) and Petersen and Johansen (1994), indicate 
the status of a more permanent site as opposed to 
temporary hunting stations. A breakdown of the 
tools from Skovmosen I shows a distribution of 
scrapers (63 %), burins (23 %) and complete as well 
as broken tanged points (14 %). This spectrum of 
tools, together with the evidence of primary on-site 
lithic production would also support the notion 
that we are dealing with a habitation site. As the 
lithic technology primarily reflects direct hard per-

Figure 8. From left to right; textured 3D model and mesh 
view of x2. 

Figure 8a. 3D rendered model of x2. 
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cussion technique, it is difficult to assign the mate-
rial to any one cultural complex or to distinguish 
Final Palaeolithic from later knapping products 
within the assemblage. Hard hammer percussion 
occurs in the Federmesser culture (Hartz 1987), 
the Bromme culture (Madsen 1983) as well as in 
the early Preboreal Maglemosian culture (Sørensen 
2006). 

Turning to the cultural historical placement 
of the Skovmosen I assemblage, the technological 
and typological traits presented above would tra-
ditionally place Skovmosen I within the Bromme 
culture. Ever since the discovery of a large tanged 
point in lacustrine deposits in the cliffs at Nørre 
Lyngby in Vendsyssel, north-western Denmark 
( Jessen & Nordmann 1915) and the later excava-
tion of the locus classicus of Bromme in eastern 
Denmark (Mathiassen 1946), the Bromme culture 
has been enshrined as an autochthonous southern 
Scandinavian Final Palaeolithic culture – repre-
sented first and foremost by the presence of large 
tanged points. The diagnostic power of this arte-
fact class has been questioned, however (Kobus-
iewicz 2009b), and a series of critical voices have 
expressed doubts as to the validity of the Bromme 
culture as an actual culture-historical phenomenon 
on par with similarly labelled ‘cultures’ elsewhere 
(Kobusiewicz 2009a; 2009b; Riede 2013; 2014; 
2017a; Sauer & Riede 2018) thereby making even 
disturbed sites such as Skovmosen I important in 
order to elucidate such a priori cultural groups as 
the Bromme culture. Put simply, the issue can be 
reduced to the diagnostic capacity and specificity 
of the types and technologies associated with the 
Bromme culture. Large tanged points occur in the 
Final Palaeolithic of Europe already well before 
the postulated emergence of the Bromme culture 
(Riede et al. 2011) independently of whether one 
follows the available long or short chronologies (cf, 
Riede and Edinborough 2012; Fischer et al. 2013). 

Spatially, the occurrence of large tanged points 
appears to correspond with the northern range ex-
pansion of the broader Final Magdalenian/Feder-
messergruppen complex and their occurrence in 
greater numbers northwards stands out as a trend 
rather than a discrete distribution of separate 
types marking separate ranges or territories (cf. 
Bokelmann 1978). The presence of large tanged 
points in Final Magdalenian/Federmessergruppen 

contexts prior to the suggested date range of the 
Bromme culture precludes the interpretation of 
their occurrence outside of its presumed ‘core area’ 
as cultural contact or expansion. Instead, an inter-
pretation of these sites as more or less specialised 
exploitation sites – related perhaps to the hunting 
of large mammals such as elk and giant deer with 
particularly heavy armatures (Tomka 2013) in the 
landscapes of late Allerød eastern Denmark where 
these animals may have been particularly abundant 
(Mortensen et al. 2014) – may be more parsimo-
nious as earlier suggested by Bokelmann (1978). 
These considerations lead us to be cautious with re-
gard to a placement of the Skovmosen I assemblage 
into the Bromme culture, as previously suggested 
by Hilgart (2003), Boye (2006) and Brinch Pe-
tersen (2009). At any rate, the Skovmosen assem-
blage is comprised only of surface finds retrieved 
semi-systematically from an already heavily dis-
turbed context. Neither lithic technology nor ar-
tefact typology can unambiguously resolve the de-
gree of admixture or the cultural affiliation of the 
assemblage. All of this severely compromises our 
ability to arrive at robust inferences regarding site 
function and chronology as the mixed nature of 
the assemblage, also hints at some later Mesolithic 
interference.

Concluding remarks

The Late Glacial in southern Scandinavia has been 
the subject of much renewed research effort lately. 
Brinch Petersen (2009) has provided a useful re-
view that, however, has plainly demonstrated that 
(i) true habitation sites of appreciable size are rare 
when compared to regions further to the south and 
that (ii) many of the known assemblages remain in-
completely published. We have here attempted to 
address the latter shortcoming by presenting and 
discussing the small Final Palaeolithic assemblage 
from Skovmosen  I. Despite obvious signs of ad-
mixture with later material, it is not unlikely that 
the assemblage can, by and large, be placed into 
the Final Palaeolithic. We are more cautious, how-
ever, about further assigning the material to any 
of the traditionally recognised Final Palaeolithic 
‘cultures’, given recent debates about their validity 
and the retrieval history as well as the likely incom-
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pleteness of the Skovmosen  I assemblage. Given 
the general rarity of Pleistocene archaeology in 
southern Scandinavia coupled with the fact that 
many Final Palaeolithic locales have discovery and 
retrieval histories not unlike Skovmosen I but are 
similarly mentioned in regional or inter-regional 
syntheses (e.g. Groß et al. 2016), we argue that our 
description makes a useful cautionary contribution 
to the present corpus of sites and assemblages. 
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Appendix 1

A Technological and Typological Analysis of Lithic Material from                
Skovmosen I, Denmark.

Eggers-Kaas, T., Pedersen, J.B., Hoggard, C.S., Sauer, F.R. and Riede, F. 

Supplementary information

SfM Recording strategy

These two workflows are designed to introduce the reader to the Structure from Motion (SfM) process, 
from the capturing of suitable images to the final creation of a 3D textured model. The first will detail 
the rig components, the setup and necessary stages, and best practice. The second workflow will con-
sider the image-process (post-masking application). This process is a modified form of the workflow 
detailed by:

 Thi Porter, S., Roussel, M. and Soressi, M. (2016). A Simple Photogrammetry Rig for the Reliable Cre-
ation of 3D Artifact Models in the Field. Lithic Examples from the Early Upper Palaeolithic Sequence 
of Les Cottes (France). Advances in Archaeological Practice , 4 (1): 71-86.

Rig Components

The following equipment and software is used throughout this SfM process:
•	 Black velvet (for the photo backdrop)
•	 Backdrop support e.g. foam tiles or boxes
•	 Turntable e.g. a kitchen turntable (used to rotate the object)
•	 Lighting (for object illumination)
•	 Kneadable rubber eraser (artefact support)
•	 Scale (see below)
•	 Camera tripod (camera support: prices vary, choose a sturdy tripod if possible)
•	 Camera (depending on the size and nature of the object)
•	 A carrying case (to support the draping of the velvet and for portability)
•	 Agisoft PhotoScan Processional Edition (photogrammetry software)
•	 Adobe Photoshop CC (for masking of the artefact background; can also be done in PhotoScan)
•	 Meshlab (3D Mesh Editing software)
•	 Optional:	Laptop with camera software e.g. EOS Utility (for remote shooting)

Rig Setup and Use

1. Open the carrying case and drape the background fabric (black velvet) over the case.
2. Set down the turntable (with the scale and colour card glued on the turntable), with the 0° mark fac-

ing forward. The scale and colour card can be found here: https://conservancy.umn.edu/bitstream/
handle/11299/172480/Photogrammetric_scale_noncoded_markers_plus.pdf ?sequence=28&isAl-
lowed=y.

3. Position the camera on the tripod at approximately the same height as the turntable. Connect the 
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camera to the laptop and load up the EOS Utility software (if remote shooting).
4. Assemble the lighting; ensure light is aimed downwards towards the turntable’s centre, and on both 

sides of the camera. Portable LED panel lamps can be used for greater portability, however they will 
have a limited lighting time and will require frequent charging.

5. Place the artefact rubber eraser on the centre of the turntable. 

Stage 1a: Photography Instructions (Remote Shooting)

A suitable folder structure is first necessary as two batches of photographs will be taken. There will be one 
folder (named by the model ID) and five subsequent sub-folders:

•	 Folder	(e.g.	ID_2405_321)
o A_Side (the images taken for the first surface of the artefact)
o B_Side (the images taken for the second surface of the artefact)
o A_Mask (the masked images for the 1st surface - produced in Adobe Photoshop)
o B_Mask (the masked images for the 2nd surface – produced in Adobe Photoshop)
o Models (the .ply, .obj files and textures produced by the process)

In EOS Utility ensure the directory is set to the location of the A_Side sub-folder. With the camera po-
sitioned at approximately the same height as the turntable, take the first picture. In line with the Archae-
ological Data Service (http://guides.archaeologydataservice.ac.uk/g2gp/Photogram_Toc ) the following 
practices were adopted:
•	 The	camera	is	always	set	to	Manual, with fine-tuning of the focus performed in EOS Utility.
•	 The	International Standards Organisation (ISO) i.e. the sensitivity of the camera’s light sensor is set 

as low as possible, in order to minimise the amount of noise in each image.
•	 Low F-stops (apertures) were avoided as they tend to leave object parts out of focus with a shallow 

depth of field (the highest possible aperture was therefore used).
•	 A short shutter speed was generally required, given the low ISO, and high aperture.
•	 If	photographs	are	taken	manually,	use	a	two-second delay in order to avoid blurriness that can result 

from movement caused by pressing the shutter button on the camera button.
Following the first picture rotate the turntable 30° so that the 30° mark is facing the camera. Take a second 
image. Continue rotating the turntable and taking photographs every 30° until the turntable has been fully 
rotated (i.e., at the 60°, 90°, 120°, 150°, 180°, 210°, 240°, 270°, 300°, and 330° marks). Using the tripod, 
raise the camera slightly and tilt it towards the target object. For small objects, we usually raise the camera 
approximately 5 to 10 cm. Rotate the turntable so that the 10° mark is facing the camera. Take a photo. 
Rotate the turntable 30° so that the 40° mark is facing the camera. Take another photo. Continue rotating 
the turntable and taking photographs every 30° until the turntable has been fully rotated (i.e., at the 70°, 
100°, 130°, 160°, 190°, 220°, 250°, 280°, 310°, and 340° marks). Raise the camera again and tilt it towards 
the target object. Rotate the turntable so that the 20° mark is facing in the direction of the camera. Take a 
photo. Rotate the turntable 30° so that the 50° mark is facing the camera. Take another photo. Continue 
rotating the turntable and taking photographs every 30° until the turntable has been fully rotated (i.e., at the 
80°, 110°, 140°, 170°, 200°, 230°, 260°, 290°, 320°, and 350° marks). At this point you should have taken 
36 photographs. Depending on the shape of the object, it may be necessary to raise and tilt the camera once 
again and take an additional round of photographs in order to sufficiently capture the top of the object. 
Usually, we take fewer photographs at this camera position (e.g., four photos with the turntable at the 0°, 
90°, 180°, and 270° positions.

Turn the object over, flipping it 180°. What was previously the top of the object should now be facing 
downward towards the turntable’s surface. Repeat the photography protocol as before, but in reverse. The 
directory should be now set to the ‘B_Side’. In other words, begin taking photos with the camera in a very 
high position and work downward systematically rotating the object as before.
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Stage 1b: Photography Instructions (Manual Shooting)
For manual shooting, the above process is largely the same. The only exception is that images should be sub-
sequent stored into a folder system following the capturing of 72+ images. Ensure that the correct images 
are in the appropriate folders.

Stage 2: Masking Procedure

For the following image-processing workflow, and the generation of high-quality 3D models, the velvet 
background is ‘masked’ from the image. This means that Agisoft Photoscan Professional will ignore the 
background. This stage is essential to the Structure from Motion operation, as we are ‘cheating’ the camera 
and that the only structure it should consider is the artefact and turntable. This can be done in Agiosoft 
Photoscan Professional (see the next workflow), MS Paint, or automated through a batch process oper-
ation in Adobe Photoshop CC. 

The masking script for this automated process is as follows:
1. Open a photo taken with the photogrammetry rig in Adobe Photoshop.
2. Open the action window by clicking on “Window” > “Action”.
3. Create a new action by clicking on the square paper icon (circled in red in the screenshot below). Give 

the new action a name, and set it as a default action. Click “Record”.
4. Using the “Magic Wand” tool a spot on the black background in the upper left hand corner of the im-

age is performed. You will want to click on a place that will consistently select the background in each 
photo, you are processing and not the object. Make sure the box next to “Contiguous” is checked (as 
indicated by the white arrow). You may want to experiment with the tolerance level, but a setting of 15 
usually works well.

5. This selection is then inverted through the “Select” > “Inverse” function.
6. If you zoom in, you will likely notice a line of black pixels is still included in your selection. To mitigate 

this, click “Select” > “Modify” > “Contract”. Contract the selection by 2 or 3 pixels, depending on the 
resolution of your photos and the size of the remaining black area you observe.

7. Now you will create an alpha channel around representing your selection. To do this, click “Select” > 
“Save Selection”. Save the selection as a new channel. Give the channel a name. Click “OK”.

8. Next, save the photo by clicking “File” > “Save As”. Save the image as a copy and a TIFF, and be sure 
to include the alpha channel. Click “Save”.

9. You can use compression in order to avoid overly large file sizes. Click “OK” to save the file.
To run a batch process click “File” > “Automate” > “Batch”. Select the script that is created, set your source 
folder as the folder containing the raw images, and choose the mask folder for your processed image. Make 
sure that “Override Action “Save As” Commands” is selected. Click “OK”. Once the batch process has 
run, if you open the designated destination folder for your processed images, the image thumbnails should 
display with a white background.

Stage 3: Importing photos (Agisoft Photoscan Professional)

•	 The	process	will	involve	two	‘chunks’	(A	side	and	B	side),	so	in	Agisoft	Professional	click	on	“Work-
space” and select “Add chunk”. Repeat twice. Chunks can be selected by double-clicking on the chunk 
description in the “Workspace” window.

•	 In	each	of	these	chunks	import	the	masked-files	(in	.tif	format)	for	each	of	these	sides.	The	masking	
will have been done in Adobe Photoshop/Paint/CorelDraw. From here, the “import masks” should 
be clicked, ensuring that the mask is from the same file.

•	 Masks	(in	original	or	silhouette	form)	can	be	checked	or	altered	in	the	“Photo” view. To alter a mask, 
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click on an image, click the “Magic Wand” tool on the top toolbar and the area you also wish to mask. 
By clicking “ctrl” + “shift” + “A” on the mask you integrate the new area into the mask. Other selection 
tools can be used to select different regions or areas. The tolerance (strength of the masking) can also be 
changed by clicking “Options…” on the “Magic Wand” icon.

Stage 4: Aligning photos (Agisoft Photoscan Professional)

•	 This	stage	allows	the	computer	to	calculate	where	the	camera	positions	are.	These	should	be	around	the	
entirety of the image, in three bands (the three camera orientations).

•	 Cameras	can	be	aligned	for	each	side	separately	or	together	using	the	“Batch Process” function under 
the “Workflow” tab. In this new window click on “Add”, choose “Align Photos” on the “Job Type” 
tab, and ensure that this is applied to “All Chunks”. A high accuracy is favourable (time vs. quality), 
but ensure that “constrain features to mask” is selected. It is always good to ensure that the project is 
saved after each stage so select “Save project after each step”, save as appropriate. Click “Ok” to run the 
process if the save function did not automatically run the process.

•	 Following	this	process,	close	the	dialogue	box	and	you	should	be	able	see	the	position	of	the	cameras	
and the aligned photos (in point cloud form). To hide the trackball, in the centre of the screen, click 
the “Show Trackball” function under “Show/Hide items” in the “View” tab.

•	 Check	that	the	camera	positions	are	in	the	correct	area	and	that	the	point	cloud	is	not	too	busy.	
•	 Note:	the	bounding	box/region	needs	to	encapsulate	all	you	wish	to	model	(including	the	scale).	To	do	

this use the region tools on the panel above the viewing window. Rotate, resize and position as neces-
sary. Whatever is not in the bounding box will not be processed further.

•	 Stray	points,	close	to	the	point	cloud,	may	hinder	the	level	of	detail	produced	throughout	later	stages.	
These can be deleted through the “Free form selection” function, with the relevant areas highlighted 
and deleted (using the “Delete” button on the keyboard). Because these are scattered and do not clus-
ter we can assume that these points are sources of error and not integral to the model.

Stage 5: Building a dense cloud (Agisoft Photoscan Professional)

•	 Using	 the	“Batch Process…” function in “Workflow” again, remove the previous process and add 
“Build Dense Cloud” to the “Job Type”. This stage will add further points now we are satisfied with 
the camera alignment. Set the “Quality” to however you see appropriate, and leave “Depth filtering” 
on “Aggressive”. “Reuse depth maps” should also be selected to “No”. Run this process. If you click on 
the “Dense cloud” option we can then view the model in greater detail. At present, this is a not a mesh 
but many points (if you zoom in you can see this). 

Stage 6: Chunk alignment, merging and mesh creation (Agisoft Photoscan Professi-
onal)

•	 This	next	stage	involves	taking	the	two	dense	clouds,	aligning	each	perspective,	and	subsequently	merg-
ing to produce one final model.

•	 The	alignment	stage	can	be	done	automatically,	however,	in	some	instances	this	may	not	work	correctly	
and manual alignment may be necessary.

•	 For	automatic	alignment,	merging	and	mesh	creation:
o Choose “Workflow” on the header, and choose “Align Chunks…”. We keep the “Method” as 

“Point based”, as we are using the dense cloud, the “Accuracy” as we see appropriate and “Point 
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Limit” to the default number. Again, we tick the “Constrain features to mask” function, so we can 
ignore the background.

o Upon completion, we can click “Show Aligned Chunks” on the icons above the viewing window, 
and see how the software has aligned the point clouds. Click off this when done.

o We can now edit these point clouds to align and consider just the dense cloud and the scale we wish 
to keep. In one chunk, using the rectangular tool we can delete the scale and putty, as previous. 
Continue to clean the image, removing noise where possible. In the second chunk, we want to keep 
some part of the scale, so we can scale appropriately later. Therefore, remove half of the scale board 
and the putty. Again, tidy as appropriate. When we again click “Show Aligned Chunks”, we can 
now see the aligned artefact with one scale bar.

o If the quality of the model is better on one part of the shape than on another chunk then the 
low-quality section of that particular chunk can be deleted, using the same stages as above.

o The chunks are still two separate entities and we now need to merge the chunks. To do that we go 
to “Workflow” and “Merge Chunks”. Here we combine the models (ignoring the markers), and 
click “Ok”. If we now click on the “Merged Chunk” we can now see one chunk with all references 
points in one model. Resize and reposition the bounding box as appropriate.

o We can now build a mesh, using the “Build Mesh” function in the “Workflow” tab. Leave the 
“Surface Type” as “Arbitrary”, “Source Data” as the “Dense cloud” and increase the polygon 
count as necessary. Always aim high (c. 500,000), it is always easy to simplify later (you can not add 
further detail later!). Leave all other options as the default and click “OK”. This step is usually quite 
quick.

o At the top, above the viewing window, we now have more options and can click the “Mesh” icon 
and see the final product. Now we can add the texture (see below).

•	 For	manual	point	alignment,	and	subsequent	merging	and	mesh	creation:
o Using markers we can align the two models. Using the “Batch Process” function, select the “Build 

Mesh” and “Build Texture”, we want a texture so we can accurately pinpoint areas of topographi-
cal correspondence (ensure that the polygon count is high!). For the texture mapping we want the 
“Blending mode” as “Average”, with a “Texture size” of 4096 and a “Texture count” of 1. Colour 
correction does not work particularly well, so leave this unticked. These processes can also be ap-
plied to the above mesh now. When these two stages have been added click “OK”. Each chunk will 
now have a mesh and a texture.

o We now need to add corresponding markers on each chunk, ready for alignment. When you have 
decided on places for the markers (roughly 8-10 will work well), right-click on the areas and choose 
“Create Marker”. Make sure that the markers are spaced out around the object (the further apart 
the better), on both sides, and that the ordering is consistent. Tip: take a screenshot of one chunk 
to better align the markers on another model.

o When the points have been placed on each chunk, go to “Align Chunks” and, this time, change the 
method to “Marker Based”. Ignore the “Fix Scale” function as we have not yet made a scale.

o After clicking “Show Aligned Chunks”, we can do the same operations as before, deleting noise in 
the dense cloud, the putty and scale bar on one image, and half of the scale bar and putty in another. 
Merge chunks as previous. We can then rebuild the mesh for this new model following the previous 
method.

Stage 7: Solving the “putty issue” (Agisoft Photoscan Professional)

•	 If	we	were	to	build	a	texture	using	the	two	models,	the	software	will	include	photographs	of	the	putty,	and	
two discoloured areas will appear: one on the top of the artefact and one on the bottom of the artefact.
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•	 To	fix	this	issue	we	will	mask	the	putty	in	the	photographs	using	the	previous	method	of	masking	(by	
using the free-form selection or the rectangular selection tools). We however have many photographs, 
and not all are necessary to make a texture, so, using the “Disable cameras” function on half of the 
photographs and mask the others.

•	 If	we	run	the	“Build Texture” function now the issue should be fixed.

Stage 8: Creating the scale (Agisoft Photoscan Professional)

•	 There	are	two	ways	a	scale	can	be	created.	Both	use	markers,	the	same	markers	used	in	the	manual	align-
ment. These are placed on the model or from the photographs.
o From the model:

> Using the “Shaded” view of the model, place two markers (of a determinable length) on the 
model by right-clicking on a position and selecting “Create Marker”. Repeat for a second 
point.

> Using the selection tools highlight both markers and select “Create Scale Bar”. In the “Ground 
Control” window (this may need to be selected from the “View” function at the top of the pro-
gram) we can now see “scale 1”. 

> If we click on the scale, we can input the correct length underneath the “Distance (m)” head-
er.

> To ensure that your model is the correct size we click “Update” at the top of the panel.
o From the photographs:

> Highlight a photograph (ideally a photograph from a pretty high angle) and add additional 
two markers on the scale, the program should auto-select the points for the other photographs 
and repeat the process as above.

o Note: If we do both methods, we can calculate the total error (as viewed in the left window).

Stage 9: Exporting the model (Agisoft Photoscan Professional)

•	 File/Export Model and choose whichever format you require (.obj and .ply are the most common 
model formats).

•	 In	the	options	we	can	choose	how	we	want	the	texture	to	be	exporting	(.jpg	is	fine).
•	 Click	“Ok” and the model should be created. We can now open this up in MeshLab or any other pro-

gram for additional tidying or modifications e.g. mesh-simplification.




